
CorelBook Help Contents
Just as a book consists of chapters, topics, and pages, the CorelBook viewer provides 
modules of information organized by chapters, topics, and pages. These modules, or books,
are intended to provide various views of information for you to browse. One book provides 
system information and another book provides CD-ROM media information.
Help topics for CorelBook are divided into two categories represented by the following 
icons:



How To...
· Work with the CorelBook viewer
· Use the System Browser Book
· Use the Media Browser Book



Working with the CorelBook Viewer
The CorelBook viewer includes several components to help you move through books and 
mark information. When a book is open, the viewer displays pages that you can flip. Each 
page provides a different type of information.
Tabs along the bottom of the book mark separate chapters of the book. When you select a 
tab, the viewer displays the first page of the chapter.
Menus provide commands that you can use to flip and print pages. You can also mark 
pages to help you quickly locate information. Online help is also available for each page.

To open a book
1. Select Open Book from the File menu.

Or press Alt F-O.
Or press Ctrl-O.

2. Double-click the book name.
Or choose OK.

To... use...
print the current page Print Page from the File menu.

Or press Alt F-P.
Or press Ctrl P.

preview the current page Print Setup from the File menu.
Or press Alt F-S.
Or press Ctrl S.

flip to the previous page Alt V-P
PGUP
Previous Page from the View menu.

flip to the next page Alt V-N
PGDN
Next Page from the View menu.

flip to the most recent page Back from the View menu.
insert a bookmark Alt B-B

Ctrl B
Toggle Bookmark from the Bookmark menu.

flip to the next bookmark Alt B-N
Ctrl PGDN
Next Bookmark from the Bookmark menu.

flip to the previous bookmark Alt B-P
Ctrl PGUP
Previous Bookmark from the Bookmark menu.

display help for the page Alt H-P
F1

display version information Alt H-A
About from the Help menu.

close the CorelBook viewer Select Exit from the File menu.
Or press Alt F-X.
Or press Alt F4.



System Browser Chapter List
Operating System
System Overview
Windows



Windows Section List
Device Capabilities
GDI Heap Information
GDI Heap Usage Chart
Global Heap
Global Heap Usage Chart
Keyboard Information
Memory Information
Module List
Mouse Information
Overview
System Metrics 1
System Metrics 2
System Metrics 3
System Parameters
Task List
Registered Window Classes

 



Keyboard
This page provides information about your keyboard, including its type, how it's set up for 
Windows, and which Windows components control it.
This page shows the description assigned to your keyboard when the keyboard driver was 
installed, the name of the keyboard device driver used in standard mode and the name of 
the virtual device driver used to control the keyboard in 386 enhanced mode.
The keyboard type and subtype identify your keyboard type. If a type value isn't displayed, 
either the keyboard driver or the BIOS chooses a default type. The following combinations 
of types and subtypes may appear:
Type Subtype Description
1 N/A IBM PC or XT compatible
2 N/A Olivetti 102-key ICO
3 N/A IBM AT compatible
4 N/A IBM compatible enhanced
1 2 Olivetti M24 83-key or AT&T 6300 type 301 83-key
1 4 AT&T type 302 for 6300 Plus
2 1 Olivetti 102-key ICO for M24 systems
The repeat speed specifies the number of characters per millisecond repeated while a key 
is pressed. The character repeat begins after the specified repeat delay, specified in 
milliseconds, has expired.
This page also indicates whether your keyboard's virtual device driver is to support PS/2 
8042 commands that implement password security. This feature only applies to 8042 
keyboard controllers that are compatible with the PS/2. The default is ON for the IBM PS/2 
and OFF for all other computers.
A layout translation table is a library that defines the keyboard layout for non-US keyboards
and non-standard keyboards. Examples of non-standard keyboards are keyboards with 20 
function keys or keyboards with more that 102 keys.
The name of the file that defines OEM-ANSI translation tables for systems not using the US. 
OEM character set is also displayed.



Mouse
This page describes the type of mouse you're using, the name of its driver used in standard
mode, and the name of the mouse driver used in 386 enhanced mode. If an asterisk 
precedes the device name, the virtual device is built into the WIN386.EXE file.
This page also shows how your mouse is set up for use with Windows and which Windows 
components control the mouse.
The double-click rectangle width and height is the width and height, in pixels, of the area in
which two mouse clicks are considered a double-click. If the mouse pointer moves out of 
the defined area, the mouse clicks are considered separate functions. The default is 4 for 
both the width and height values. By default, if a second mouse click occurs more than two 
pixels from the first mouse click, two distinct mouse clicks occur.
The double-click speed is the speed, in milliseconds, at which two mouse clicks must occur 
to be considered a double-click. The default is 452 milliseconds. 
The threshold values specify the number of pixels that the mouse can move between 
mouse interrupts before the relationship between the mouse and the cursor movement is 
changed. The relationship between mouse and cursor movements is defined by the mode 
value:
Mode Description
0 no acceleration occurs.
1 the cursor moves at twice the normal speed when the value of Threshold1 is 

exceeded. This is the default value.
2 the cursor moves at twice the normal speed when the value of Threshold1 is 

exceeded or four times the normal speed when the value of Threshold2 is 
exceeded.

Mouse trails are enabled using the Mouse dialog box of the Control Panel. Mouse trails 
specify the number of pointers displayed on the screen when the mouse pointer is moving. 
Not all display drivers support mouse trails. By default, the mouse trails option is turned off.
The maximum number of trails indicates the most of mouse pointers the display driver can 
draw as mouse trails.



Windows Summary
This page provides general information about your Windows system. The information is a 
combination of data available on other pages and information from the [boot] and 
[boot.description] sections of the SYSTEM.INI file.
This page displays the name of the directory where Windows is installed. This directory 
contains the executable and accessory programs. The name of your system driver and the 
description given to your system by the setup program during installation is also provided.
The display driver is the driver Windows uses to control the video display hardware. The 
display driver name is provided by either the hardware OEM (original equipment 
manufacturer) or by one of the standard display drivers provided with Windows.
This page also displays the file name of the network driver you're using, the name of your 
keyboard driver, and the name of your mouse driver. The descriptions provided by the 
setup program when the drivers were installed are also displayed.
The system language is the name of the dynamic-link library that supplies language-
specific functions. If no language library is specified, Windows uses the US English library.
This page also indicates whether Windows is running in enhanced or standard mode, and 
whether Windows is using the debugging kernel. The kernel files provide information about 
Windows and how it handles I/O operations, system task scheduling, and memory. Unless 
the development version of the Window's kernel files is installed, the debugging kernel flag 
is off.
This page also indicates whether Windows is running under OS/2 version 2.1 and whether a
screen saver is to be activated when the computer is idle. The value 0 turns off screen 
savers and the value 1 turns on screen savers.
32 bit disk access is a collection of Windows components that work only when Windows 3.1 
is running in 386 enhanced mode. The device driver for your disk controller must be able to
support this option.
If overlapped I/O is enabled, more than one DOS session can make read and write requests 
to a disk before the first request is completed.



System Metrics 1
This page provides the sizes of various system-wide objects on the display screen.
For sizable windows, non-sizable windows, and dialog boxes, the size of the border width 
and height is displayed. This page also displays the width and height of the horizontal and 
vertical scroll arrows, scroll bar thumbs and title bar bitmaps such as the minimize button 
and the close box.



System Metrics 2
This page provides the size, in pixels, of various system-wide objects on the display screen, 
including the
· desktop window. This may not be the same as the resolution provided by your display 

card. The size of the desktop window depends on the video driver and its settings.
· smallest possible window, which is usually equal to the screen size.
· largest possible inside portion of a window. Generally, this size is the same as the 

maximum window size less the height of the window caption and border widths.
· largest mouse cursor.
· area in which two mouse clicks are considered a double-click. If the mouse pointer 

moves out of the defined area, the mouse clicks are considered separate functions. The 
default is 4 for both the width and height values. By default, if a second mouse click 
occurs more than two pixels from the first mouse click, two distinct mouse clicks occur.

· icons the system is using.
This page displays the height of the window caption, the Kanjii window, and a single line 
menu bar. Fields also provide information about the number of pixels between icons and 
whether drop-down menus are aligned with the right or left hand side of the menu header.



System Metrics 3
This page provides general information about Windows, including whether
· Windows is using a double-byte character set, which is used for languages where the 

standard ASCII 8 bit character set doesn't have enough symbols to represent all the 
symbols of the language.

· the Windows debugging kernel is running.
· Windows detects the presence of a mouse.
· the Pen version of Windows is installed.
· Windows is set to swap the functions of the left and right mouse buttons. 



System Parameters
This page provides miscellaneous system information, most of which can be changed using 
the Control panel.
If the warning beep is enabled, the system beeps when you try something that isn't 
allowed. Fast task switching lets you switch between applications using Alt+Tab.
Menu drop alignment indicates whether drop-down menus are aligned with the left or right 
side of menu headers. The value 0 indicates that menus are aligned with the left header, 
The value 1 indicates that menus are aligned with the right header.
The screen saver fields indicate whether a screen saver is to be used if the computer is idle
and the amount of time, in seconds, which the computer must be idle before the screen 
saver is activated.
The threshold values display the number of pixels that the mouse can move between 
mouse interrupts before the relationship between the mouse and the cursor movement is 
changed. The relationship between mouse and cursor movements is defined by the mode 
value:
Speed Description
0 no acceleration occurs.
1 the cursor moves at twice the normal speed when the value of the first threshold 

value is exceeded. This is the default value.
2 the cursor moves at twice the normal speed when the value of the first threshold 

value is exceeded or four times the normal speed when the value of the second 
threshold value is exceeded.

This page also indicates
· whether icon title can be word wrapped.
· the width of the borders around all windows that have sizable borders. The value ranges

from 1 which the narrowest to 49 which is the widest. The default value is 3.
· the granularity of the grid to which windows are aligned when you position them on the 

screen. The default value is no grid or 0.
· the type face name of the font used by icon titles.
· the number of pixels between icons horizontally and vertically
The keyboard repeat fields specify the number of characters per millisecond repeated while
a key is pressed and the number of milliseconds Windows waits after you press a key 
before repeating the key on the display.



Window Classes
Each window has a class that defines its generic or default behavior. A window class is a 
template for a particular type of window. This page displays
· the list of window classes registered in the system. 
· the name of the selected window class.
· the handle, a Windows internal value, for the class.
· the name of the module which created this class. 
· the disk file name of the module that created this class. 
· a module usage reference count. Each time this module is loaded, the usage count 

increases by 1. Each time this module is released from memory, the usage count 
decreases by 1. When the usage count becomes 0, the module is unloaded.



Modules
A module is a unique component of the system; only one of each module type can be 
loaded into memory at a time. Examples of modules include executable files and fonts. This
page displays
· a unique identifier assigned to each module to which other programs can refer.
· the unique name of the module in memory. 
· a module usage reference count. Each time another this module is loaded, the usage 

count increases by 1. Each time this module is released from memory, the usage count 
decreases by 1. When the usage count becomes 0, the module is unloaded.

· the name of the disk file from which this module was loaded.



Tasks
A task is a Windows program that's currently running on your system. Unlike modules, you 
can run two copies of a task; however, both copies share the same module. This page 
displays
· the names of all the Windows programs you're running.
· a unique identifier assigned to each module to which other programs can refer.
· the name of the disk file from which this task was loaded.
· the name of the module, usually the Program Manager, which started the task. Some 

programs, such as Program Manager, don't have a parent.
· the name of the disk file from which the parent module was loaded.
· the name of the first non-child window in the system whose owner is the current task. 

This field can help identify a task that isn't identifiable from the other fields.
· the total amount of code that this task has on the Windows global memory heap. Some 

of this code may be swapped out to disk.
· the total memory, excluding code, that's associated with this task.
· the size of the stack that the current program is using.



Memory
This page attempts to show you about the lowest level of memory management in 
Windows:
· the size, in bytes, of a single page of linear memory. This is the granularity imposed on 

the linear address space by the memory manager.
· the number of pages of memory which have been swapped out to disk.
· the largest number of contiguous linear memory pages available.
· the number of pages that can be locked into memory. Once locked, the memory can't 

be swapped out to disk.
· the number of pages of linear memory that aren't currently in use.
· the total number of pages of linear memory.
· the size of the largest, block in bytes, of unused contiguous linear memory.
· the total amount of linear memory in pages.
· the amount of memory which isn't locked and can be paged out to disk if the system's 

memory is low.
· the number of free pages in the linear address space.
· the percentage of your system resources that is free. Windows displays this value in 

Program Manager's About box. The value displayed is the lower of Free User Resources 
and Free GDI Resources.

· the percentage of free user heap space. The free user heap space is displayed as a 
percentage of the total user heap space.

· the percentage of GDI heap space which is free. The free GDI heap space is displayed 
as a percentage of the total GDI user heap space.

· the size of the swap file in kilobytes.
· the directory location and file name of the swap file.
· whether Windows has created a permanent swap file.



Device Capabilities
This page provides information about the capabilities of display devices such as printers, 
monitors. From the Device list box, you select a device. From the Information list box, you 
select the type of information you want to view for the selected device. You can obtain 
information about the device's
· Raster capabilities
· Curve capabilities
· Line capabilities
· Polygon capabilities
· Text capabilities
· Device Driver capabilities
· Resolution capabilities



Global Heap
The global heap is a chunk of memory where Windows reserves space for certain objects. 
Windows and its programs can allocate and free portions of the global heap. This page 
displays
· a list of global heap memory objects.
· whether the selected global heap object is a local heap.
· the name of the module which owns this object.
· the number of times the memory page on which the selected global heap object resides

has been locked.
· the number of times the selected global heap has been locked.
· a value which represents the resource type of the object.



Global Heap Usage Chart
This page displays a bar chart of each Windows module responsible for more than 1% of 
the allocated memory on the global heap. Many modules consume small amounts of the 
memory, but the modules shown in this bar chart are the ones most responsible for your 
memory usage.



GDI Heap
The Graphics Device Interface (GDI) is the part of Windows responsible for drawing on the 
screen, printer, and other devices. The GDI heap is a pool of memory used by objects 
supported by GDI.    This page displays the amount of space occupied in the GDI heap by 
each type of GDI object and summary information about the GDI heap.



GDI Heap Usage Chart
This pie chart shows the relative usage of your GDI heap. The pie represents the entire GDI 
heap. It's usage is broken down in to free memory and the types of objects which are found
on the GDI Heap. For clarity, all device contexts are grouped together.



Operating System Section List
Protected Mode Memory Information
Real Mode Software Interrupts
Protected Mode Software Interrupts
Real Mode Hardware Interrupts
Protected Mode Hardware Interrupts
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DOS Overview
DOS Device Driver List
SmartDrive Disk Cache Information
DOS Open File List



Protected Mode Memory Information
The DPMI Server information includes the
· version of the DPMI specification, which is provided by DOS. Windows 3.1 provides DPMI

v0.90.
· interrupt number, in hex, for the slave programmable interrupt controller, if one is 

installed, and the master programmable interrupt controller
· processor you're using
The memory information includes the
· size, in kilobytes and pages, of the largest free block of contiguous linear memory
· maximum number of locked pages
· maximum number of pages that can be allocated and locked
· total number of pages of linear memory
· number of pages of linear memory unlocked, including free pages
· number of pages of linear memory that are unused
· number of pages that can fit into RAM
· number of pages of free linear memory
· size of the swap file used to provide virtual memory in pages
· size of each page



Real Mode Software Interrupts
This page provides information about the addresses of routines available to the operating 
system and all programs running in the system when the system is operating in real or 
virtual 8086 mode. 
For each of the software and hardware interrupts that the CPU supports, this page provides
· the number, in hex, of the interrupt
· the address that the interrupt vector currently contains. The address is provided using 

real mode addressing in the format segment:offset.
· the name of the DOS process that currently owns the interrupt
· a brief description of the interrupt's use



Protected Mode Software Interrupts
This page provides information about the addresses of routines available to the operating 
system and all programs running in the system when the system is operating in protected 
mode. 
For each of the software and hardware interrupts that the CPU supports, this page provides
· the number, in hex, of the interrupt
· the address that the interrupt vector currently contains. The address is provided using 

the format segment:offset.
· the name of the Windows module that owns the global heap object which contains the 

interrupt handling code for this interrupt
· a brief description of the interrupt's use



Real Mode Hardware Interrupts
This page provides information about the address of routines called when the system's 
programmable interrupt controller (PIC) generates an interrupt. These routines are never 
called by programs; they're only called in response to the PIC. These routines are called in 
real or virtual 8086 mode.
For each real mode hardware interrupt, this page provides
· number, in hex, of the interrupt
· the address that the interrupt vector currently contains. The address is provided using 

the format segment:offset.
· the name of the DOS process that will handle this interrupt
· a brief description of the interrupt



Protected Mode Hardware Interrupts
This page provides information about the address of routines called when the system's 
programmable interrupt controller (PIC) generates an interrupt. These routines are never 
called by programs; they're only called in response to the PIC. These routines are called in 
protected mode.
For each of the 16 hardware interrupts from $8 to $f and $70 to $7f, this page provides
· number, in hex, of the interrupt
· the address that the interrupt vector currently contains. The address is provided using 

the format segment:offset.
· the name of the Windows module responsible for the global heap object which contains 

the interrupt handling code for this interrupt.
· a brief description of the interrupt



DOS Loaded Programs List
This page lists the addresses and the names of the DOS resident processes. For each 
process listed, this page displays the 
· name of the program for which information is displayed. This information comes from 

the DOS memory control block just before the PSP for this process.
· size, in bytes, of all of the segments that this process owns.
· real mode segment containing the process ID (PSP) for this process, which DOS uses as 

its process ID.
· segment address of this process's environment variables.
· number of file handles available to the process.
· command line switches used when this program was started.
· list of interrupts owned by this process. The Real Mode Software Interrupt page shows 

you the function of these interrupts.
· PSP for the process that started the current process
· name of this process's parent
· list of memory blocks that this process owns. Some programs that are loaded into low 

memory and then allocate extra memory own memory blocks in both low and high 
memory.



DOS Overview
This page provides general information about DOS. Some information on this page is 
covered in more detail on other pages. The DOS overview page provides the following 
information:
· reported version of DOS version, which can be changed using SETVER
· actual version of DOS
· version of Windows
· DOS original equipment manufacturer
· number of file handles and disk buffers
· last local drive available
· whether DOS is loaded in ROM or high memory
· whether SmartDrive and DBLSPACE are active



DOS Device Driver List
This page provides a list of the DOS device drivers that are loaded. For each device driver, 
this page displays the
· address in memory of the device driver header using the form segment:offset.
· name of the device driver.
· address of the device driver's interrupt handler using the form segment:offset.
· address of the device driver's strategy routine, which DOS calls to invoke the device 

driver using the form segment:offset.
· 16 bit attribute word, in hex, that gives information about the device's capabilities.
· number of units, for block devices, that this device driver controls.



SmartDrive Disk Cache Information
The SmartDrive page is available if you're using the SmartDrive disk cache or any cache 
that implements the same API as SmartDrive. The following general cache information is 
listed:
· version of SmartDrive
· the number of cache hits, the number of cache misses, and efficiency percentage. A 

cache hit occurs when requested data is found in the cache. If must be read from the 
media, a cache miss has occurred. The more cache hits that occur, the higher the 
efficiency.

· element size, in bytes, of each chunk of cache memory that SmartDrive is allocating, in 
sectors.

· the maximum number of cache elements that SmartDrive will use.
· the maximum number of cache elements that SmartDrive will use when Windows is 

running. SmartDrive can decrease its cache usage automatically when Windows is start 
to free more memory for Windows.

· the size, in kilobytes, of the current cache
Using the drive list box, you can select a logical or physical drive for which you want the 
following cache information:
· whether SmartDrive is willing to cache this drive. Not all drives marked as cacheable 

can actually be cached by SmartDrive. If SmartDrive is started with no arguments, a 
message indicates which drives are available for caching and what the drive status is. 

· whether SmartDrive has its read cache enabled for this drive. This cache doesn't affect 
disk writes.

· whether SmartDrive is caching writes. When a program writes to a disk, SmartDrive 
saves the data in a cache buffer. Caching writes may provide a significant performance 
boost. However, if a system interruption occurs before SmartDrive writes this data to 
the disk, you could lose data.

· whether SmartDrive has allocated a disk buffer in conventional memory for some older 
hard disk controllers that don't support Microsoft's Virtual DMA services. Typically the 
disk buffer is approximately 2.5K and has the same physical and virtual address. The 
Windows 3.1 installation will enable SmartDrive double-buffering if it's required for your 
system.



DOS Open File List
This page lists all the files that are open in the DOS system file table. For each open file, 
the following information is provided:
· the location in real mode memory of the file control block. The location is specified 

using the form segment:offset.
· the base name of the file.
· the name of the owner of the file. Each file control block contains the PSP (DOS process 

ID) of the owner of the file. The name shown here is the name in the memory control 
block just prior to the PSP. If there is no string here, then the memory just before the 
PSP isn't an MCB.

· the read/write permission with which the file was opened: read-only, read/write, or 
write-only.



System Overview Section List
System Overview
BIOS Keyboard Information
Video Hardware Information
CMOS Summary
BIOS Summary
BIOS Strings
VESA



System Overview
This page provides general information about your hardware and software:
· the processor you're using and whether math processors are installed. The 80486DX 

series processors have built-in math processors.
· the type of bus: "ISA" for ISA or EISA machines, and "MCA" for MicroChannel systems.
· the type of video adapter. SuperVGA cards will be listed as "VGA".
· the type of keyboard as recorded in your SYSTEM.INI file
· the type of mouse
· the number of serial and parallel ports as reported by the BIOS
· the number of physical drives and logical drive letters. The number of logical drives is 

usually the number indicated by the LASTDRIVE command in your CONFIG.SYS. The 
logical drives value defaults to 5.

· the amount, in kilobytes, of memory below and about 1 MB.



BIOS Keyboard Information
This page provides information known to DOS about your keyboard. The BIOS keyboard 
information indicates the type of support provided with your keyboard. The keyboard buffer
length indicates the number of keystrokes that the keyboard buffer can hold. Windows has 
it's own keyboard buffering system; this number applies only when you're not using 
Windows.
The keyboard shift and status checkboxes indicate whether certain keys are currently 
pressed. For example, if you press NumLock, the corresponding checkbox changes to 
indicate a new key status.



Video Hardware Information
This page provides the information about your video subsystem that's available from the 
system BIOS:
· the type of display adapter in your system.
· the amount of memory, in kilobytes, available to your video card: 64, 128, 192, or 256. 

Often, if the BIOS reports 256K, your card has much more memory.
· the type of display such as color or monochrome
· the current video mode that your card is in. This is an 8 bit hex number which the 

system uses to identify this video mode.
 If you've installed a VESA driver or the VESA specification is implemented in the video bus,
detailed SuperVGA information is available from the VESA page.



CMOS Summary
CMOS RAM is non-volatile: when the computer is off, CMOS RAM is backed up via a battery. 
Generally, if a problem occurs with this battery, information is lost and your computer won't
boot. CMOS RAM requires a continuous electrical signal to refresh.
This page provides general information, stored in CMOS RAM, about your computer 

hardware:
· the mode in which your system starts up: 40x25 color, 80x25 color, 80x25 

monochrome, or "Reserved"
· the amount of memory below and above 1 MB. These values should be the total amount

of memory installed in your system, excluding any genuine expanded memory cards.
· whether your system clock has lost power since the last time it was used.
· whether the CMOS checksum is invalid, which indicates that the information in the 

CMOS RAM should be considered invalid.
· whether your CMOS is set up incorrectly
· whether the amount of RAM your CMOS counted when you started the machine up is 

different from the number that it has stored as your memory size.
· whether your hard disk was initialized.
· whether the time that the system is reporting is invalid.
· the type of your first and second floppy drives.
· the type of your first and second hard disk. Many small drives display default types. 

Some BIOS ROMs support more than the standard table of drives and any new hard disk
is not going to be available as a default choice. Therefore, type 47 indicates that the 
hard disk information is stored as a number of cylinders, heads, and so on, which the 
BIOS can use as the disk's characteristics.



BIOS Summary
This page displays the following BIOS summary information:
· the reported date of the BIOS. This date is encoded in a string found at the very end of 

the BIOS ROM. Often, other dates are recorded in the BIOS, which you can view using 
the BIOS Strings page.

· the revision level, contained in a single byte, of this BIOS.
· a string, usually found near the start of the BIOS ROM, which identifies the 

manufacturer of the ROM.
· whether hard disks driven by your BIOS ROM use DMA channel number 3.
· whether a second interrupt chip is included in your system
· whether your system has a standard clock.
· whether the keyboard hardware interrupt handler will call the keyboard intercept 

interrupt
· whether the PS/2 is using E000-FFFF instead of F000-FFFF
· the type of system bus (ISA, EISA, MCA)



BIOS Strings
This page lists all of the ASCII strings found in the entire BIOS ROM, starting from segment 
0xF000. A string is any part of memory that contains more than six consecutive printable 
characters. The list shows the offset into the ROM and the string found. Words that would 
extend off the right side of the list are wrapped to the next line.



VESA
This page requires that, when you start CorelBook, you have a VESA (Video Electronics 
Standards Association) Video BIOS Extension (VBE) loaded for your video card or that your 
BIOS implements the VESA API. Most video cards come with a VESA driver and many newer
video cards have the VESA driver in the video BIOS.
The following information is provided:
· the name of the video card's manufacturer.
· the version of the VESA standard which the driver supports.
· the current video mode of the card, which may be a mode that isn't a supported VESA 

mode.
· the list of modes that the card supports and a brief summary of each mode, including 

the type, graphics or text, resolution, and color depth.
· whether the card supports this mode. The card can have modes in its mode list that it 

doesn't support. For example, this card may not have enough memory for the specified 
mode.

· whether the section of the VESA information that is marked as "optional" is actually 
provided. OEM VESA modes, modes with numbers below 256, are required to supply the
optional information.

· whether the standard BIOS video output functions will work if the card is in this mode.
· whether the mode supports color.
· whether its a text mode rather than a graphics mode. If the mode is a text mode, then 

the Mode list box displays the width and height of the character cell in pixels as well as 
the number of rows and columns of text.

Window A provides information about the first of the two windows on the video memory 
that the card can support. Standard VGA cards have a 64K read/write window    at segment 
$A000. Some video cards have two windows: a 64K read window and 64K write window. 
With two windows, you can read from one page and write to another page without 
switching pages.
Window B provides information about the second of the two memory windows.
This page also displays how pixels are stored in this graphics mode. 256 color VGA is a 
"packed pixel" format, meaning that all of the bits for a pixel are stored together. Seven 
different memory modes are supported by VESA.
The DAC palette width is the number of bits per pixel that your video card supports. A card 
isn't required to supply this information.
The Window granularity is the size of the 'units' in which the video memory paging can be 
controlled. SuperVGA graphics modes often require much more than the 64K memory area 
allocated to the VGA card. In this case, the video memory is paged into the memory 
windows in banks.



Media Chapter List
Track Information
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Track Information
The Track Information page displays information about each track on a CD. The tracks on 
the CD are listed on the left side of the page.
This page displays the track number of the selected track. The track's start location and 
length are also provided. The unit of measurement these fields is determined by the 
selected Address format: M:S:F (minutes, seconds, and frame) or sector numbers. The 
Ctl/ADR field indicates the type of information on the track.
If the track is a data track, a button is displayed beside the Start location text box, which 
flips to the hex dump information page for the track. If this track includes file system 
information, a button is provided which flips to the file system information page. Unless 
you're using a multi-session CD, only one track includes file system information. The file 
system information begins at sector 16, offset 0.

For multi-session CDs, each session begins in a new track. Each session can include 
one or more tracks.
This page indicates the number of audio channels for audio tracks; for example, 2 channel 
(stereo) or 4 channel (quadraphonic). The "Audio with pre-emphasis" field indicates, for 
audio tracks, that the treble range has been boosted during disc mastering.
This page also indicates whether the author or publisher of this information permits the 
information to be copied.
You choose the drive that contains the CD for which you want information displayed using 
the Drive Selection box. The Disc Type is displayed in the upper left corner of the page. The
Update button updates the information displayed on the page when you change CDs in the 
current drive.



Drive Selection box



Disc Type
Displays one of the following:
· Data disc -- if the CD includes only data tracks
· Audio disc -- if the CD includes only audio tracks
· Mixed Mode disc -- if the CD includes both data and audio tracks
· No disc -- if a CD hasn't been inserted in the drive



Update button



Volume Descriptors
The volume descriptors page displays information for the primary and terminator volume 
descriptors. The sequence of volume descriptors always begins at sector 16. Every ISO-
9660 or High Sierra formatted CD includes at least one primary volume descriptor and one 
terminator volume descriptor, although other volume descriptors may be present. You can 
choose which type of volume descriptor you want to display on this page using the Volume 
Descriptors list box. If more than one primary or terminator volume descriptor exists on 
your CD, each is listed.
In the file system of ISO-9660 and High Sierra discs, each volume descriptor contains data 
in both the Intel or Motorola formats; you can view information using either one.
From this page, you can flip to the hex dump information for this volume descriptor using 
the Hex Dump button.
A primary volume descriptor is the starting point for finding information on the CD; it 
describes the volume of information represented by this file system. For example, the 
primary volume descriptor provides the location of the path table and root directory file.
CorelBook provides the following types of information for the primary volume descriptor:
· root directory information
· path table information
· general information
· identifiers information
The terminator volume descriptor is used to mark the end of the available sequence of 
volume descriptors. It doesn't actually contain any other information.
You choose the drive that contains the CD for which you want information displayed using 
the Drive Selection box. The Disc Type is displayed in the upper left corner of the page. The
Update button updates the information displayed on the page when you change CDs in the 
current drive.



Disc Type
Displays one of the following:
· ISO-9660 -- if the disc uses the IS0-9660 format
· High Sierra -- if the disc uses the High Sierra format
· Unknown -- if the disc is neither ISO-9660 nor High Sierra formatted
· No disc -- if a CD hasn't been inserted in the drive



Logical blocks
The smallest allocation unit of information in the file system is a logical block. Often, the 
logical block is the same size as the sector size, 2048 bytes. However, if the CD includes 
many small files, the logical block size may be smaller (512K or 1024K). 
A logical block number (LBN) is used to identify a specific logical block, just as a sector 
number identifies a specific sector.



Intel and Motorola formats
The difference between the Intel and Motorola format is the ordering of bytes in numeric 
data.



Hex Dump button



Path Table Information
A path table is an indexing system which is used to quickly find the location of any sub-
directory in the file system. The path table holds only sub-directory information; it doesn't 
contain any data file information. 
The path table information provided by the volume descriptor includes the
· length, in bytes
· location, using the logical block number. A button flips to display the selected path table.
· the location of the alternate path table, if used.
· the logical block size, in bytes, of all file system and data files: 512, 1024, 2048.



Root Directory information
The root directory referred to in this information is the directory represented on DOS 
systems by "\" -- the topmost level of the directory hierarchy. Information provided by the 
volume descriptor includes the
· the root record length
· the root record's extended attribute record length
· the location, using the logical block number, of the root directory file. The button 

displayed beside this box flips to the Directory File page.
· the length, in bytes, of the root directory file
· the date and time of the root directory file
· the root directory file's interleave size
· the root directory file's interleave skip
· the logical block size, in bytes, of all file system and data files: 512, 1024, 2048
· the attributes of the root directory file: hidden, sub-directory, associated file, defined 

format, protected, multi-extent
Primary volume descriptors for ISO-9660 and High Sierra discs include a copy of the 

directory record for the root directory. This information is duplicated from the first record in 
the directory file for the root directory.



General information
General information describes the volume such as when the volume was created and what 
version of the file structure was used to create the volume.

"Volume" doesn't refer to the audio level. It refers to one component of a set of 
similar information.



Identifiers information
The Identifiers information provides specific information about the volume:
· the target system, or platform, which is meant to understand the information on the 

disc.
· the name of the volume. The first 11 characters of this name are used by DOS as the 

volume label for this disc.
· the name of the volume set in which this disc is included.
· the name of the publisher and author of the information, and the application that is 

expected to understand the information on this disc. If the first character in these fields 
is an underscore (_), then the remainder of the field specifies the file in which the 
appropriate information is provided. 

· the names of the files that contain copyright, abstract, and bibliographic information for
the disc

Any file names specified by these identifiers are assumed to be located in the root 
directory.



Path Table
This page displays information about the path tables contained in the file system. A path 
table is an indexing system which is used to quickly find the location of any sub-directory in
the file system. The path table holds only sub-directory information; it doesn't contain any 
data file information. 
This page provides the sector and offset location of a path table. The file system of every 
IS0-9660 and High Sierra formatted disc includes two different types of path tables: one 
that contains Intel formatted data and another that contains Motorola formatted data. 
Duplicate copies of path tables may also be present. This page displays the ISO-9660 or 
High Sierra 
· path table length, in bytes
· path table location, using a logical block number
· total number of records in the path table
· the maximum depth of the directory tree hierarchy
The list on the left side of the page lists the name, or ID, of each sub-directory in the 
current path table. The name is displayed as it's stored on the disc. The name may be 
different than how it's interpreted and displayed by DOS. For the selected path table 
record, this page displays the
· DOS name of the record, which is the name of the selected sub-directory as interpreted 

by DOS.
· sub-directory file location, using a logical block number. The button beside this box flips

to the Directory File page for this record.
· level of the record. The level indicates how deep into the directory tree this sub-

directory is located.
· a button that provides detailed information such as the record number and length.
Hex Dump buttons are provided for flipping to the hex dump information for the online path
table and the selected path table record.
You choose the drive that contains the CD for which you want information displayed using 
the Drive Selection box. The disc type is displayed in the upper left corner of the page. The 
Update button updates the information displayed on the page when you change CDs in the 
current drive.



Disc Type
Displays one of the following:
· ISO-9660 -- if the disc uses the IS0-9660 format
· High Sierra -- if the disc uses the High Sierra format
· Unknown -- if the disc is neither ISO-9660 nor High Sierra formatted
· Audio disc -- if all the tracks on the disc are audio tracks. Audio discs don't include path 

tables.
· No disc -- if a CD hasn't been inserted in the drive



Directory File
The Directory File page displays information about the directory files on a CD. The name, or
ID, of each file or sub-directory in the current directory file is listed on the left side of the 
page. The list shows the names as they're stored on the disc, which may be different than 
how the names are interpreted by DOS. For example, version numbers, such as :1, may be 
included in the list on this page, but not when the name is used by DOS.
In the file system of ISO-9660 and High Sierra discs, each directory file includes information
in both the Intel or Motorola formats; you can view information using either one.
From this page, you can flip to the hex dump information for this directory file using the 
Hex Dump button.
The information displayed for the current directory includes
· the path of the directory from the root directory to the current directory
· the total number of records in the current directory file
· the location, using a logical block number, of the current directory file
· the size, in bytes, of the current directory file
The information displayed for the selected file or sub-directory includes information such as
its DOS name, size, and location using the logical block number. You can also flip to the 
sector dump page and hex dump information for a selected data file or the sector dump 
page and sub-directory information for a selected directory file.
You choose the drive that contains the CD for which you want information displayed using 
the Drive Selection box. The disc type is displayed in the upper left corner of the page. The 
Update button updates the information displayed on the page when you change CDs in the 
current drive.



DOS name
The name of the selected file or sub-directory as interpreted by DOS.



Disc Type
Displays one of the following:
· ISO-9660 -- if the disc uses the IS0-9660 format
· High Sierra -- if the disc uses the High Sierra format
· Unknown -- if the disc is neither ISO-9660 nor High Sierra formatted
· Audio disc -- if all the tracks on the disc are audio tracks. Audio discs don't include 

directory files.
· No disc -- if a CD hasn't been inserted in the drive



Sector Dump
A hex dump displays information as it's recorded on the CD. The sector dump page displays
the current drive, the label of the current sector, the sector and offset numbers of the hex 
dump, the number of bytes are dumped, and the size, in bytes, of the sector, either 2048 or
2352. 
Use the Parameter selection button to specify the sector size, start sector, start offset, and 
data length parameters to dump. You also specify whether to use cooked mode or raw 
mode. Cooked mode reads only the data portion of the sector. Raw mode, if supported by 
your drive, reads the entire contents of a disc sector, including error correction codes.

Some drives and drivers may also be capable of displaying hex dump information 
from audio frames and sectors on audio CDs. This requires selecting Raw mode from the 
parameters selection dialog box. 




